
OreAD Layou~ for Windows® 

Getting Started 

. This manual provides step-by-step process 
descriptions that explain how to get started using 
DrCAD Layout software. Reference information 
(such as information about particular commands, 
tools, or dialog boxes) is in Layout's online help. 
Placing reference information in the online help 
makes it possible for DrCAD to provide complete 
and up-to-date information to you. In addition, 
information may be easier to find in the online help 
because of its search capabilities. 



Copyright © 1997 OrCAD, Inc. All rights reserved. 

OrCAD, OrCAD Capture, OrCAD Design Desktop, OrCAD Layout, and OrCAD Simulate are registered 
trademarks, and OrCAD Express, SmartDrag, SmartPlace, SmartRoute, and SmartWire are trademarks of 
OrCAD, Inc. 

Microsoft, Visual Basic, Windows, Windows NT, and other names of Microsoft products referenced herein 
are trademarks or registered trademarks of Microsoft Corporation. 

All other brand and product names mentioned herein are used for identification purposes only, and are 
trademarks or registered trademarks of their respective holders. 

MN-01-5111 

First Edition 7 July 97 

Technical support 
Corporate offices 
Fax 

General email 
Technical support email 

Web site 

(503) 671-9400 
(503) 671-9500 
(503) 671-9501 

info@orcad.com 
techsupport@orcad.com 

www.orcad.com 

OrCAIJM 
9300 S.W. Nimbus Avenue 

Beaverton, Oregon 97008 • USA 



Contents 

About this manual ............................................................................................ vii 
Before you begin...................................................................................................... vii 

Symbols and conventions .... ..................................................................................... vii 

The keyboard.................................................................................................... vii 

Text ................................................................................................................... viii 

Chapter 1 Board design tasks ............................................................... 1 
Board design flow.................................................................................................... 2 

Typical board design tasks....................................................................................... 2 

Creating a Capture netlist for use in Layout.......................... .................... .............. 3 

Chapter 2 Creating a board ...................................... ........................ ...... 5 
Methods to create a board........................................................................................ 6 

Creating a board from scratch.................... ...... ........................................ ......... 6 

Creating a board using a board template ............................. ,............................ 7 

Importing a board from a mechanical CAD application................................... 9 

Chapter 3 Setting up board parameters ................................................ 11 
Creating a board outline ........................................................................................... 12 

Setting units of measurement ....................................... ' ............................................ 13 

Setting system grids ................................................................................................. 14 

Adding mounting holes to a board................................ ........................................... 16 

Defining the layer stack .................................................................. ,.... .................... 17 

Defining global spacing values................................................................................ 18 

Defining padstacks ............... ;................................................................................... 19 

Defining vias ............................................................................................................ 20 

DrCAD Layout for Windows Getting Started iii 



Contents 

Chapter 4 Placing components ............................................................. 23 
Preparing the board for component placement ........................................................ 23 

Checking the board, place, and insertion outlines ............................................ 24 

Checking the place grid ............. ," ...................................................................... 25 

Checking mirror layers and library layers ............... : ........................................ 25 

Weighting and color-coding nets ...................................................................... 26 

Checking gate and pin information................................................................... 27 

Securing pre-placed components on the board ................................................. 28 

Creating height or group keepins and keepouts ................................................ 29 

Loading a placement strategy file ..................................................................... 30 

Disabling the power and ground nets ............................................................... 30 

Placing components manually .... ~ ............................................................................ 31 

Selecting the next components for placement .................................................. 32 

Placing component groups ................................................................................ 33 

Using Mincon to optimize placement. .............................................................. 33 

Checking placement................................................................................................. 34 

Using Place Design Check ................................................................................. 34 

Using the density graph .................................................................................... 35 

Viewing placement statistics ............................................................................ 36 

Chapter 5 Routing critical nets .............................................................. 37 
Push-and-shove routing ........................................................................................... 37 

Interactive routing .................................................................................................... 37 

Before you begin routing ......................................................................................... 38 

Preparing the board for routing ................................................................................ 39 

Routing the board manually ..................................................................................... 39 

Loading a routing strategy file.......................................................................... 40 

Routing power and ground ............................................................................... 41 

Using interactive push-and-shove routing ............................................................... 44 

Setting an interactive routing strategy ...... ............ ............................................ 44 

Using the Shove Route tool .............................................................................. 45 

Checking routing .................................................................................... ................. 46 

Changing board density using routing strategy files ........................................ 46 

Viewing routing statistics ................................................................................. 47 

iv DrCAD Layout for Windows Getting Started 



Contents 

Chapter 6 Checking the board .................................... , .......................... 49 
Using Board Design Check ...................................................................................... 49 

Using Board Space Check ....................................................................................... 50 

Using Board AutoCDE ............................................................................................ 50 

Using Board AutoDFM ........................................................................................... 51 

Investigating errors.... .... ........... ................... ......... .......... .................................... ..... 51 

Post processing ......... : ............................... :.............................................................. 52 

Index .................................................................................................................. 53 

OrCAD Layout for Windows Getting Started v 





About this manual 

This manual contains the procedures you need to get started with board design using 
OrCAD Layout software. You can use these procedures with the entire Layout 
product family (Layout, Layout Plus, and Layout Engineer's Edition). 

Before you begin 

Before you can use Layout, you must install Microsoft Windows on your computer, 
then install Layout. For information on installing Windows, see your Windows 
documentation. 

To install Layout, follow the installation instructions that accompany Layout. 

Symbols and conventions 

The keyboard 

OrCAD printed documentation uses a few special symbols and conventions. 

• The keys on your keyboard may not be labeled exactly as they are in this 
manual. All key names are shown using small capital letters. For example, the 
Control key is shown as CTRL; the Escape key is shown as ESC. 

• Keys are frequently used in combinations or sequences. For example, SHIFT+Fl 

means to hold down the SHIFT key while pressing Fl. ALT, F, A, means to press 
and release each of these keys in order: first ALT, then F, then A. 

• Arrow keys is the collective name for the UP ARROW, DOWN ARROW, LEFT 

ARROW, and RIGHT ARROW keys. 

• To choose a command from a menu, you can use the mouse or press a key 
combination. For example: from the File menu, choose Open (ALT, F, 0). 
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About this manual 

Text 

• Text you are instructed to type is shown in bold. For example, if the manual 
instructs you to type * .max, you type an asterisk, a period, and the lowercase 
letters max. The text you type is usually shown in lowercase letters, unless it 
must be typed in uppercase letters to work properly. 

• Placeholders for information that you supply (such as filenames) are shown in 
italic. For example, ifthe manual instructs you to type cd directoryname, you 
type the letters cd followed by a space and the name of a directory. For 
example, for a directory named CIRCUITS, you would type cd circuits. 

• Examples of syntax, netlist output, and source code are displayed in monospace 
font. For example: /NOOOI U1 (8) U2 (1);. 
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Chapter '1 

Board design tasks 

This manual was created especially to address specific tasks that electronic design 
engineers perform. Depending on where you fall in the task list below, you'll use 
some or all of Layout's capabilities to accomplish your board design tasks. The 
"See" notation below each bullet item directs you to the chapters or sections in this 
manual that pertain to your specific tasks. 

• Designing a board from start to finish. 

m See The entire manual. 

• Reviewing boards that others have created. 

m See Checking placement, Checking routing, and Checking the board. 

• Specifying placement and critical routing. 

m See Placing components, Checking placement, Routing critical nets, Checking 
routing. 
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Chapter 1 Board design tasks 

Board design flow 

The flowchart below illustrates a typical board design flow. 
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! I 
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Typical board design tasks 

Typical board design tasks include the following: 

• Board creation. Using Capture, you create a netlist from your schematic that 
may include your design rules to guide logical placement and routing, then load 
the netlist into Layout. For instructions on this, see Creating a Capture netlist 
for use in Layout in this chapter. For instructions on importing netlists from 
other applications into Layout, see Chapter 17: Importing and exporting files in 
the OrCAD Layoutfor Windows User's Guide. 

• Component placement. You use the manual placement tool to place 
components on the board individually or in groups. 

• Board routing. You route the board, and can take advantage of push-n-shove 
(an automatic routing technology), which moves tracks to make room for the 
track you are currently routing. 
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Chapter 1 Board design tasks 

• Post processing. Layout's post processing settings are stored in a spreadsheet 
that you can display and revise, if necessary. You can give layer-by-Iayer 
instructions for writing to Gerber files, DXF files, or the Windows print 
manager. 

• Layout includes GerbTool, which is a full-featured CAM tool, including a 
Gerber editor, that reads and writes all standard Gerber formats and IPC-
356. GerbTool has features for automatic tear-dropping, panelization, 
venting and thieving, and removal of unused pads and silkscreen on pads. 
These processes are used to improve manufacturability. 

• Layout also includes Visual CADD, which is a two-dimensional drafting 
tool you can use for your mechanical design needs. Visual CADD 
facilitates design and drafting by providing tools for creating board 
outlines, height keepins and keep outs, and similar objects, as well as single 
or double lines, circles, regular and irregular polygons, and more. Visual 
CADD imports and exports .DWG, .DXF, and .GCD files. 

• Intertool commnnication. You can forward annotate updated schematic 
information from Capture to Layout, or back annotate board information from 
Layout to Capture. 

Creating a Capture netlist for use in Layout 

m See For information on adding Layout-supported footprints, or on transferring 
properties to Layout, see Chapter 18: Using Capture with OrCAD Layout for 
Windows in the OrCAD Capture for Windows User's Guide. 

Fb Note You should update part references, perform design rules checking, and 
create a netlist in Capture's logical mode, unless you intend to use cross-probing. 
In order to use cross-probing between Capture and Layout, you should update part 
references and perform design rules checking in logical mode, but you must create 
a netlist in physical mode. 

1 From Capture's Tools menu, choose Update Part References. The Update Part 
References dialog box displays. 

2 Select the Update entire design option, then choose the OK button. Capture 
updates the part references. 

3 From the Tools menu, choose Design Rules Check. The Design Rules Check 
dialog box displays. 
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Chapter 1 Board design tasks 

4 Select the Check entire design option and the appropriate settings in the Report 
group box, select the appropriate settings in the ERC Matrix tab, then choose 
the OK button. Capture checks for design rule violations, and reports problems 
in the session log and in a .DRC file. 

S Correct the errors and warnings, save the design, then run Design Rules Check 
again to ensure that the problems no longer exist. 

Fb Note Depending on your design, some errors and warnings may be acceptable 
to you (for example, a "Power connected to power" error). You can adjust the 
settings in the ERC Matrix tab in the Design Rules Check dialog box to report 
errors as warnings, or to ignore errors and not report them. 

6 In Capture's project manager, choose the Logical option. 
or 
If you intend to perform cross probing, choose the Physical option. 

~~ Caution A copy of the LAYOUT.INI file must exist in the same directory as 
Capture's DSN2MNL.DLL in order to generate a netlist. 

7 From the Tools menu, choose Create Netlist. The Create NetIist dialog box 
displays. 

8 Choose the Layout tab. The Layout tab displays. 

9 Verify that {PCB Footprint} is displayed in the Combined property string text 
box and that the Run ECO to Layout option is not selected. 

m See For information on combined property strings, see Capture's online help. 

10 Select the appropriate units (inches or millimeters). 

~~ Caution Layout will not read in a netlist created in inches if the board is in 
millimeters, and vice versa. If you select millimeters in the step above, you'll need 
to use millimeters with your board (see Setting units o/measurement in Chapter 2). 

11 In the Netlist File text box, verify that the path for the netlist file is correct, then 
choose the OK button. Capture creates a .MNL file and saves it in the directory 
you specified. 

Fb Note If Capture is unable to create a .MNL file, the errors are written to the 
Capture session log and to the .ERR file in the target directory for the .MNL file. 

Fb Note You may choose to exit Capture at this time. It is not necessary to run 
Capture and Layout simultaneously to take advantage of forward annotation. It 
takes a minimum of 16 MB of RAM to run both Capture and Layout. 
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Chapter 2 

Creating a board 

Before you begin creating a board, read the following to become more familiar with 
the types offiles you may be working with. 

A netlist file (.MNL) describes the interconnections ofa schematic design using the 
names of the nets, components, and pins. A netlist contains the following: 

• Footprint names 

• Electrical packaging 

• Component names 

• Net names 

• The component pin for each net 

• Net, pin, and component property information 

W See For instructions on creating a Layout netlist in Capture, see Creating a 
Capture netlistfor use in Layout in Chapter I in this manual. For instructions on 
importing netlists from other applications into Layout, see Chapter 17: Importing 
and exportingfiles in the OrCAD Layoutfor Windows User's Guide. 

A technology template (. TCH) specifies the characteristics of a board, including 
manufacturing complexity and component type. Technology templates can also 
include the layer structure, grid settings, spacing instructions, and a variety o(other 
board criteria. The technology templates supplied with Layout are documented in 
Appendix A: Understanding the files used with Layout in the OrCAD Layout for 
Windows User's Guide. 

A board template (.TPL) combines a board outline and possible mounting holes, 
edge connectors, and other physical board objects merged with Layout's default 
technology template, DEFAULT.TCH. The board templates supplied with Layout 
are iHustrated in the OrCAD Layoutfor Windows Footprint Libraries manual. 

m See Other board criteria, such as units of measurement, system grids, and 
spacing values can be saved with a board template for use with future boards. For 
instructions on creating a custom board template (. TPL), see Custom templates in 
Chapter 5: Setting up the board in the OrCAD Layout for Windows User's Guide. 

A board file (.MAX) contains all of the board's physical and electrical information. 
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Chapter 2 Creating a board 

Methods to create a board 

You can create a board using one of the following methods: 

• Create it from scratch 

• Use a board template 

• Import it from a mechanical CAD application 

Creating a board from scratch 

Technology I--

template (.TCH) 

~ AutoECO - New board -
file (.MAX) 

Netlist -
file (.MNL) 

To create a board from scratch 

1 Ensure that a netlist with all footprints and other necessary information has been 
created. (See Creating a Capture netlist for use in Layout in Chapter 1.) 

2 Create a directory in which the schematic design, netlist, and board will coexist 
and put the schematic design (if you have it) and netlist in it. OrCAD provides a 
directory (ORCADWIN\LA YOUT\DESIGN) for this purpose. 

3 From the Layout session frame's File menu, choose New. The Load Template 
File dialog box displays. 

4 Select a technology template (.TCH),'then choose the Open button. The Load 
Netlist Source dialog box displays. 

! Tip If your board uses metric units, use METRIC.TCH. 

5 Select a netlist file (for example, design_name.MNL), then choose the Open 
button. The Save MAX Board dialog box displays. 

6 Specify a name for the new board (for example, design_name.MAX), then 
choose the Save button. The AutoECO process begins. 

7 Ifnecessary, respond to the Link Footprint to Component dialog box (choose 
the dialog box's Help button for an explanation of the dialog box's options). 

8 AutoECO finishes, and you see the components in the design window. 

9 Draw a board outline using the steps in To create a board outline in Chapter 3. 
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Chapter 2 Creating a board 

Creating a board using a board temp/ate 

Board -
templat!! (.TPL) 

~ AutoECO .. New board -
file (.MAX) 

Netlist -
file (.MNL) 

! Tip One benefit of using a board template (.TPL) is that, in addition to 
containing all the information in DEFAULT.TCH, a board template contains a 
board outline, saving you the task of having to draw one yourself. 

Fb Note To determine which of the board templates (.TPL) you want to use, you 
can view their illustrations in the DrCAD Layoutfor Windows Footprint Libraries 
manual, or you can do the following: 

• From the Layout session frame's FiIe" menu, choose Open. The Open Board 
dialog box displays. 

• Change to the ORCADWIN\LA YOUT\DATA directory, change the Files of 
type to All Files (*.*), select a board template (.TPL), then choose the Open 
button. The board template displays in Layout. 

• Inspect the board template to determine if you want to use it for your new 
board. Ifnot, repeat the process as many times as necessary to find a .TPL file 
you want to use, then close the file. 

W See If you find a board template that is similar to what you want to use but 
needs some modification, you can customize it and save it under another name 
using a .TPL extension. For instructions on creating a custom board template, see 
Custom templates in Chapter 5: Setting up the board in the DrCAD Layout for 
Windows User's Guide. 

Fb Note Ifa board template has components (such as edge connectors), then you 
must have matching parts with matching reference designators in your schematic 
design in order for Layout to assign nets to the components. If the reference 
designators do not match, Layout will bring in a new part, and the components 
that are part of the board template will not have nets assigned to them. 
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Chapter 2 Creating a board 

To create a board using a board template 

1 Ensure that a netlist with all footprints and other necessary information has been 
created. (See Creating a Capture netlist for use in Layout in Chapter 1.) 

2 Create a directory in which the schematic design, netlist, and board will coexist 
and put the schematic design (if you have it) and netlist in it. OrCAD provides a 
directory (ORCADWIN\LA YOUT\DESIGN) for this purpose. 

3 From the File menu, choose New. The Load Template File dialog box displays. 

4 Select a board template (.TPL), then choose the Open button. The Load Netlist 
Source dialog box displays. 

5 Select a netlist file (for example, design_name.MNL), then choose the Open 
button. The Save MAX Board dialog box displays. 

6 Specity a name for the new board (for example, design_name. MAX), then 
choose the Save button. The AutoECO process begins. 

7 Ifnecessary, respond to the Link Footprint to Component dialog box (choose 
the dialog box's Help button for an explanation of the dialog box's options). 

8 . AutoECO finishes, and you see the components in the design window. 
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Chapter 2 Creating a board 

Importing a board from a mechanical CAD application 

Technology I-
template (.TCH) 

Mechanical CAD IDXFtoMAX~ New board -
file (.DXF) file (.MAX) H AutoECO.: New board 

file (.MAX) 
DXF initialization I- Netlist -

file (.IN!) file (.MNL) 

To import a board from a mechanical CAD application 

1 Ensure that a netlist with all footprints and other necessary information has been 
created. (See Creating a Capture netlistfor use in Layout in Chapter 1.) 

2 Create a directory in which the schematic design, netlist, and board will coexist 
and put the schematic design (if you have it) and netlist in it. OrCAD provides a 
directory (ORCADWIN\LA YOUT\DESIGN) for this purpose. 

3 Create a board outline in Visual CADD (or in another mechanical CAD 
application), save it (and any other pertinent floor planning information) as a 
.DXF file, then put the .DXF file in the same directory as your schematic design 
and netlist. 

m See For instructions on creating a board outline and saving it as a .DXF file in 
Visual CADD, and on modifying the MAXDXF initialization file (which specifies 
the mapping of data betWeen DXF and Layout formats), see the OrCAD Layout 
for Windows Visual CADD Tutorial. For instructions on using Visual CADD, see 
the OrCAD Layout for Windows Visual CADD User's Guide. 

4 From Layout's session frame, choose File, then Import, then DXF to MAX. The 
DXF to MAX dialog box displays. 

5 In the Input DXF File text box, use the Browse button to locate and select the 
.DXF file you created in step 3. 

~:c. Caution If the .DXF file was created using millimeters, the DXF to MAX result 
will be a metric board (.MAX). Therefore, your netlist must also be in millimeters, 
because Layout will not read in a netlist created in inches if the board is in 
millimeters (and vice versa). 

6 In the Output Layout File text box, supply a name for the output .MAX file. 
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Chapter 2 Creating a board 

7 VerifY that MAXDXF.INI displays in the DXF .INI File text box and that 
DEFAULT.TCH displays in the Technology File text box, then choose the 
Translate button. Layout combines the files and displays the results of the 
translation in a text editor, such as Notepad. Close the text editor when you're 
finished viewing the translation results. 

8 From Layout's session frame, choose File, then Open. The Open Board dialog 
box displays. 

9 Locate and select the .MAX file that you supplied the name for in step 6, then 
choose the Open button. The board displays in Layout. 

1 0 Review the board, ensuring that the datum is where you want it and the drill 
chart is in an acceptable location (for example, to the right ofthe board outline, 
to keep it out of the way of components that will load with the netlist). When 
the board is as you want it, save it (using a .MAX extension) and exit Layout. 

rn See For instructions on moving the datum, see the final step of Creating a 
board outline in Chapter 3 in this manual. For instructions on moving the drill 
chart, see MOVing the drill chart in Chapter 15: Post processing in the OrCAD 
Layout for Windows User's Guide. 

~ Tip You can save the board you've reviewed in step 10 as a board template 
(.TPL), so that you can reuse it. For instructions on creating a custom board 
template, see Custom templates in Chapter 5: Setting up the board in the OrCAD 
Layout for Windows User's Guide. 

11 From the Layout session frame's File menu, choose New. The Load Template 
File dialog box displays. 

12 Change the Files of type to Board (*.MAX), locate and select the .MAX file you 
saved in step 10, then choose the Open button. The,Load Netlist Source dialog 
box displays. 

13 Select a netlist file (for example, design_name.MNL), then choose the Open 
button. The Save MAX Board dialog box displays. 

14 SpecifY a name for the new board (for example, design_name.MAX), then 
choose the Save button. The AutoECO process begins. 

15 If necessary, respond to the Link Footprint to Component dialog box (choose 
the dialog box's Help button for an explanation of the dialog box's options). 

16 AutoECO finishes, and you see the components in the design window. 
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Chapter 3 

Setting up board parameters 

In Layout, you should set up the board's parameters before you begin placing 
components. The parameters are listed below, but not all of them may be needed for 
your board. 

• Create a board outline 

• Set the units of measurement 

II Set system grids 

II Add mounting holes 

• Define the layer stack 

• Set global spacing 

II Define padstacks 

II Define vias 

m See All of the items listed above can be saved to board templates. For 
instructions on creating a custom board template (.TPL), see Custom templates in 
Chapter 5: Setting up the board in the OrCAD Layout for Windows User's Guide. 
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Chapter 3 Setting up board parameters 

Creating a board outline 

~:.. Caution Layout requires one board outline, which must be on the global layer. 

To create a board outline 

1 From the Tool menu, choose Obstacle. 

2 From the View menu, choose Zoom Out, then click on the screen until you can 
see the entire board. Press ESC to exit zoom mode. 

3 From the pop-up menu, choose Insert, then from the pop-up menu, choose 
Modify. The Edit Obstacle dialog box displays. 

4 From the Obstacle Type drop-down list, select Board outline. 

S In the Width text field, enter the desired value for the outline's width. 

~ Tip Layout has a 50 mils default board outline width, in order to provide 
clearance on plane layers for the copper of the plane to the edge of the board. One
half ofthe width is the pullback (25 mils in the default width), so set the board 
outline's width to two times the pullback you would like. 

6 From the Obstacle layer drop-down list, select Global Layer. 

7 Choose the OK button. The Edit Obstacle dialog box closes. 

8 Move to the point on the board at which you want to start drawing the outline, 
then click the left mouse button to insert the first corner. 

R:J Note Since a board outline must be a closed polygon, Layout automatically 
begins forming a closed area after you insert the first corner of the board outline, 
and automatically closes the polygon for you if you don't close it yourself. 

9 Continue clicking the left mouse button to insert corners. 

10 After you click to insert the last corner, choose Finish from the pop-up menu. 
Layout automatically completes the board outline. 

11 From the Tool menu, choose Move Datum, then click on the lower left corner of 
the board outline to place the datum (to provide a starting grid for component 
placement). Press HOME to redraw the screen. 

~!:. Caution Placing the datum in the lower-left corner of the board outline gives 
you positive X, Y coordinates, while placing it in other corners gives you negative 
coordinates (in your reports and post processing results). In addition, since the 
board datum is used for all grids, if you move the datum after component 
placement, your place, routing, and via grids will all be affected. And, you may 
have difficulty replacing the datum at the precise location you moved it from. 
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Chapter 3 Setting up board parameters 

Setting units of measurement 

In Layout, you can set numeric data to display in mils, inches, microns, millimeters, 
or centimeters. You can change these values as needed (for example, you can route 
the board in inches or mils, then confirm pad locations within footprints in 
millimeters ). 

~ Tip If your board uses metric units, you can achieve the best precision by using 
the METRIC.TCH technology template. With your board open in Layout, choose 
Load Template File from the File menu, select METRIC.TCH, then choose the 
Open button. After METRIC.TCH loads, save your board. 

To set measurement units 

1 Open your board in Layout. 

2 From the Options menu, choose Units. The Display Units dialog box displays. 

3 Select mils, inches, microns, millimeters, or centimeters. 

4 In the Precision text box, specify a value to indicate the degree of accuracy with 
which you want Layout to report system coordinates (such as the X, Y 
coordinates that display in the status bar). 

~ Tip The best functionality in Layout occurs when the precision is left at its 
default setting of 0.00100". 

5 Choose the OK button. 
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Chapter 3 Setting up board parameters 

Setting system grids 

Using the System Grids dialog box, you can set five distinct grid settings, as well as 
rotation angle, and some routing parameters. The grid values that you assign 
determine the resolution of the pointer location coordinates given in the status bar in 
the lower lefl comer. For example, if the Obstacle tool is selected and the Place grid 
is set to 100 mils, the coordinates that display are accurate to 100 mils. 

Grid values are in user-specified units that you set in the Units dialog box (from the 
Options menu, choose Units). If you want to use fractions in your grid values, enter 
a space character following the integer and use a forward slash as the divisiori 
character (for example, 8 113). You can also use decimals for rational numbers. 

~ Tip Here are some rules of thumb for setting the grids: 

• For efficient routing performance, the routing grid and via grid should have the 
same value. 

• The place grid must be a multiple of the routing and via grids. 

• The routing grid should never be less than 5 mils. 

• The detail grid can be set as low as 1 mil for better resolution. 

• Components are placed on the place grid using the component datum, which is 
typically pad 1 (unless the component has been modified). 

To set system grids 

1 From the Options menu, choose Grid. The System Grids dialog box displays. 

2 Set these options: 

• Routing grid. Assigns the grid used for routing (see the routing grid chart 
below for suggested routing grids). 

• Via grid. Assigns the grid upon which you or the router can place vias. 

• Allow off-grid routing. When enabled, the router can place tracks off-grid, 
if needed, to route a pad off-grid. 

• Use all via types. When enabled, the router can use any ofthe vias defined 
in the Padstacks spreadsheet. 

• Unrestricted via spacing. When enabled, you or the router can place a via 
closer to a pad of the same net than the via-to-pad spacing specified in the 
Edit Spacing dialog box. With this option enabled, the via can be placed 
contiguous to or on top of the pad. (You should manually check the spacing 
of vias.) 

• Shove components. If enabled, the router is allowed to shove components 
in order to efficiently route a track. 
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Chapter 3 Setting up board parameters 

Dot grid. Assigns the grid for the visible grid dots. 

Place grid. Assigns the component placement grid. For greatest routing 
efficiency, this value needs to be a multiple of the routing grid. The datum, 
or origin, of footprints is constrained to this grid. 

Detail grid. Assigns the drawing grid for lines and text objects. 

Increment. Assigns rotation increment (up to one minute of resolution). 

Snap grid. Assigns the finest rotation increment for use when the place 
grid value and the increment value are very small. This is especially useful 
on a round board for precise angular placement of components. 

3 Choose the OK button. 

The following chart is a synopsis of routing grids and how to use them in Layout. 

Grid Uses 

Compatible grids 25, 12112. 8%, and 6114: 

25,12112 Use for less dense (usually .45 density or greater) through-hole 
and SMT boards, and for routing one track between IC pins. 

Use for a secondary grid on through-hole boards, and for a 
primary grid on SMT boards. Use as a secondary grid with 25 
mils grid only if the 25 mils grid initially routes 95% or better. 

Use for 6/6 technology, or more dense one-between boards. 

Compatible grids 20 and 10: 

20 

10 

Use for through-hole boards only. This is the most efficient way 
to route two tracks between IC pins. 

Use for through-hole, two-between boards placed on a 50 mils 
grid and for SMT boards using 10110 technology. Also, use for 
special cases when a 20 mils grid causes off-grid jogs. 

Compatible grids 25, 20, and 10: 

5 Use for extremely dense SMT boards that use 5 mils spacing 
and 5 mils track width (for mixed inch and metric technologies). 

Fb Note Incompatible grids such as 20 and 25 should not be mixed on the same 
board. If you find it necessary to do so, use a 5 mils grid for the final reroute pass. 
Also, a via grid smaller than the routing grid (for instance, a 5 mils via grid on a 
25 mils grid board) increases completion on difficult SMT boards. Of course, if a 
board is very dense, via sizes should by reduced to the minimum size possible, as 
vias are responsible for much of the channel blockage during routing. 
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Chapter 3 Setting up board parameters 

Adding mounting holes to a board 

If desired, you can add mounting holes to your board, and you can save them in a 
board template (.TPL). Once you add the mounting holes to the board, define them 
as non-electrical in order to use them as part of a board template. 

To add mounting holes to your board 

1 From the Tool menu, choose Component. 

2 From the pop-up menu, choose Insert. The Add Component dialog box displays. 

3 Select the Footprint button. The Select Footprint dialog box displays. 

4 In the Libraries window, select SHEET23.LLB. Use the Add button if necessary 
to add this library to the list of available libraries. (SHEET23.LLB resides in the 
LIBRARY directory.) 

5 In the Footprints window, select a mounting hole (OrCAD provides three: 
MTHOLEl, MTHOLE2, and MTHOLE3). Choose the OK button to close the 
Select Footprint dialog box. 

6 Select the Non-Electric option, then choose the OK button to close the Add 
Component dialog box. The mounting hole attaches to your cursor. 

7 Place the mounting hole in the desired location by clicking the left mouse 
button. 
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Chapter 3 Setting up board parameters 

Defining the layer stack 

Routing and documentation layers are defined in the Layers spreadsheet. Using the 
spreadsheet, you can define the number of routing layers that will be used for the 
board. If you plan to have a board with four routing layers (TOP, BOTTOM, 
INNER!, and INNER2) and two plane layers, then you need to define the layers in a 
technology template (.TCH) or a board template (.TPL). 

~ Tip It is better to have too many routing or plane layers defined than too few (if 
you're unsure of the number that you will need) before reading in a netlist, 
because you can decrease the number of these layers later. Allowing for excess 
layers ensures that all padstacks come into the board defined correctly on all 
needed layers. Since padstacks for routing layers and plane layers are different 
sizes (padstacks must be larger on plane layers to give clearance on plane layers), 
it is easier to prevent the work of having to redefine a layer later. Also, if a layer is 
not enabled for routing, then the padstack may be loaded as Undefined, which 
means that you will need to redefine that padstack if you add layers. 

After defining the layer stack, you can save the information to a board template 
(.TPL) for use in future boards. 

To define layers for routing 

1 Choose the spreadsheet toolbar button, then choose Layers. TheLayers 
spreadsheet displays. 

~:- Caution Do not delete layers from the Layers spreadsheet. To disable layers, 
specifY them as Unused Routing in the Edit Layer dialog box. 

2 Review the type assignments for the routing layers and double-click in the 
Name column ofa layer you want to modifY. The Edit Layer dialog box 
displays. 

3 In the Layer Type group box, select the desired option (for example, to disable a 
layer for routing, select Unused Routing; to define an additional plane layer, 
select Plane Layer). 

4 If you changed a routing layer to a plane layer, change the Layer LibName to 
PLANE. 

5 Choose the OK button. 
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Chapter 3 Setting up board parameters 

Defining global spacing values 

Global spacing values set rules for spacing between the various objects on the board. 
You can define global spacing values for the board using the Edit Spacing dialog 
box, which is accessed from the Route Spacing spreadsheet (choose the spreadsheet 
toolbar button, choose Strategy, then choose Route Spacing). You can save spacing 
requirements in a board template (.TPL). 

~ Tip To globally assign the same spacing to all layers, double-click on the Layer 
Name title cell in the Route Spacing spreadsheet. When the Edit Spacing dialog 
box displays, enter a value in the appropriate text box (for example, enter a value 
for Track to Track spacing), then choose the OK button. 

To define global spacing values 

1 Choose the spreadsheet toolbar button. 

2 Choose Strategy, then choose Route Spacing. The Route Spacing spreadsheet 
displays. 

3 Double-click on the layer you want to modify. The Edit Spacing dialog box 
displays. 

4 Set these options: 

• Track to Track Spacing. Tracks are defined as any routed track and 
copper obstacles (such as keepouts and place outlines). Track-to-track 
spacing specifies the minimum space required between tracks of different 
nets, and between tracks and obstacles of different nets. 

• Track to Via Spacing. Track-to-via (and obstacle-to-via) spacing specifies 
the minimum space required between vias and tracks of different nets. 

• Track to Pad Spacing. Track-to-pad (and obstacle-to-pad) spacing 
specifies the minimum space required between pads and tracks of different 
nets. 

• Via to Via Spacing. Specifies the minimum space required between vias of 
different nets. 

• Via to Pad Spacing. Specifies the minimum space required between pads 
and vias ofthe same net (as well as different nets, which is the usual case). 
For instance, to keep a distance of25 mils between your SMT pads and the 
fanout vias connected to the pads, set Via to Pad Spacing to 25. 

• Pad to Pad Spacing. Specifies the minimum space required between pads 
of different nets. 

5 Choose the OK button. 
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Chapter 3 Setting up board parameters 

Defining padstacks 

Padstacks define the pads of the footprint. They possess properties on each layer of 
the board, such as shape and size. If you are using the standard Layout footprint 
libraries, or if you have made your own footprints using Layout standards, you have 
used padstacks T1 through T7 to create most of the standard through-hole 
components in your library. The use of each padstack is defined as follows: 

• T1: Round IC pads 

• T2: Square IC pads 

• T3: Round discrete pads 

• T4: Square discrete pads 

• T5: Round connector pads 

• T6: Square connector pads 

II T7: Via SMT stringer pads 

~~ Caution Never name your padstacks using the names T1 through T7, because 
they will be overwritten by technology template padstacks whenever a technology 
template is loaded. 

You can create new padstacks when you set up the board, or in the footprint library. 
You must define padstacks before you assign them to footprints. You can define new 
padstacks by copying and editing existing padstacks in the Padstacks spreadsheet. 
Then, you can assign them to footprints or footprint pins. After you create new 
padstacks, you can save them in a board template (.TPL) for use with future boards. 

m See F or information on assigning padstacks to footprints or footprint pins, and 
on editing padstacks, see Chapter 14: Creating and editingfootprints in the 
DrCAD Layoutfor Windows User's Guide. 

To create a new padstack 

1 Choose the spreadsheet toolbar button, then choose Padstacks. The Padstacks 
spreadsheet displays. 

2 Select a padstack or pads tack layer and choose ModifY from the pop-up menu. 
The Edit Padstack dialog box displays. 

3 Type a new name for the padstack in the Padstack text field, edit the other 
options to change the size or shape as desired, then choose the OK button. 
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Chapter 3 Setting up board parameters 

Defining vias 

During the board setup process, you can define the types of vias that you want to use 
in your board, including size and target layer. Layout initially provides you with one 
defined via, plus spaces for fifteen more. You must define additional vias in the Edit 
Padstack dialog box to· make them available for routing. Then, using the Assign Via 
dialog box, you can assign a specific via to be used when routing a particular net. 

Selecting a via for a particular net does not prohibit any other net from using that 
via. The assignments made in the Assign Via dialog box simply override, for 
selected nets, the Use all via types option set in the System Grids dialog box. 
Therefore, you can check the Use all via types option and still assign specific vias to 
specific nets in the Assign Via dialog box. 

For example, if you want to use Via 1 for all of your signal routing, but you want to 
restrict vee to Via 2 and GND to Via 3, you would start by selecting the Use all via 
types option to make the defined vias available for routing. Then you would select 
vee in the Nets spreadsheet, choose Assign Via per Net from the pop-up' menu, and 
in the Assign Via dialog box, select Via 2. Finally, you would select GND in the 
Nets spreadsheet, choose Assign Via per Net from the pop-up menu, and in the 
Assign Via dialog box, select Via 3. 

If you do not select the Use all via types option in the System Grids dialog box, you 
must specifically assign vias to all nets that need their via types restricted. 
Otherwise, the router chooses what it considers the "best" via, using its standard 
criteria. 

To make a via available for general routing 

1 Choose the spreadsheet toolbar button, then choose Padstacks. The Padstacks 
spreadsheet displays. 

2 Select a via and choose Modify from the pop-up menu. The Edit Padstack 
dialog box displays. 

3 Type a new name for the via and edit the other options to change the size or 
shape as desired, then choose the OK button. 

4 From the Options menu, choose Grid. The System Grids dialog box displays. 

5 Select the Use all via types option and choose the OK button. 

20 DrCAD Layout for Windows Getting Started 



Chapter 3 Setting up board parameters 

To assign a via to a net 

1 Choose the spreadsheet toolbar button, then choose Nets. The Nets spreadsheet 
displays. 

2 Select the net to which you want to assign a via. 

3 From the pop-up menu, choose Assign Via per Net. 

4 Select the desired via and choose the OK button. 

Fb Note You don't have to select Use all via types to assign a via to a particular 
net. 

m See For information on changing the definition of a via, see Changing vias in 
Chapter 9: Routing the board in the OrCAD Layout for Windows User's Guide. 
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Chapter 4 

Placing components 

Once you have set up your board by following the procedures in Chapter 3, you can 
begin component placement. 

Preparing the board for component placement 

Before you begin placing components manually, it is important to set up the board 
properly. Use the list below as a pre-placement checklist. 

" Check the board, place, and insertion outlines 

II Check the place grid 

II Check mirror or library layer settings 

" Weight and color-code nets 

• Check pre-placed components and secure them on the board using the Fix 
Comps or Lock Comps commands 

• Create component height keep ins and keep outs or group keep ins and keepouts 

• Verify that your components have the proper height assigned to them if you are 
using height keep ins and keep outs 

• Check gate and pin data 
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Chapter 4 Placing components 

Checking the board, place, and insertion outlines 

The board outline is used by Layout to determine the overall board placement 
boundary, and it must be present on the global layer of the board. It can be defined 
as part of the board template, or you can create it when you set up the 1:)oard. 

A place outline defines the extent of the area that is reserved for a component's 
placement. Each footprint must have one. Layout uses place outlines to determine 
whether any component spacing violations occur during placement. A place outline 
can be assigned a height and a layer. One or more place outlines of different heights 
and shapes, and on different layers, can be used to more closely represent the 
placement area required by a component. 

~ Tip If you enable the 3D Effects option in the User Preferences dialog box 
(accessed by choosing User Preferences from the Options menu), and have 
assigned a height for a place outline, Layout displays a three-dimensional image 
representing the component's height, and indicates the height on the image. 

An insertion outline is optional, and is used by Layout to provide clearance for auto
insertion machines. 

Fb Note An insertion outline can overlap another insertion outline, but a place 
outline cannot overlap another place outline. 

To check board, place, and insertion outlines 

1 Choose the spreadsheet toolbar button, then choose Obstacles. The Obstacles 
spreadsheet displays. 

2 Press SHIFT+D to view the physical properties of the board outline. Ifthere are 
"cutouts" in the board outline where no components should be placed, you need 
to create "zero-height" keepouts inside the cutouts to ensure that no components 
are placed in these areas. 

m See F or information on creating height keepouts, see Creating height or group 
keep ins and keepouts in this chapter. 

m See For information on creating board outlines, see Chapter 3 in this manual. 
For information on creating place and insertion outlines, see Chapter 6: Creating 
and editing obstacles in the OrCAD Layout for Windows User's Guide. 
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Checking the place grid 

The place grid affects the spacing used for component placement. Before placing 
components, check the setting for the place grid in the System Grids dialog box. 

The default placement grid is 100 mils, with which you can use routing grids of 25 
mils, 20 mils, 12112 mils, 10 mils,8 1h mils, 61/4 mils, or 5 mils (because 100 mils is a 
multiple of these values). 

~ Tip If you use a 50 mils or 25 mils placement grid, you can use routing grids of 
25 mils, 12112 mils, 10 mils, 8113 mils, or 61/4 mils. 

The standard metric placement grids are 2 mm, 1 mm, and 0.5 mm. 

To check the place grid setting 

1 Choose Grids from the Options menu. 

2 Check the value in the Place grid text box and choose the OK button. 

Checking mirror layers and library layers 

You can check which layers are set up to have their obstacles, padstacks, and text 
mirrored to another layer during component placement, and change the settings, if 
necessary. For example, all of the TOP layer components can be automatically 
mirrored to the BOTTOM layer, and vice versa. 

Typically, all inner layers ofa design (INNER!, INNER2, and so on) correspond to 
the INNER library name, and all plane layers of a design (POWER, GND) 
correspond to the PLANE library name. All other layers typically have a one-to-one 
correspondence; for example, the BOTTOM layer in the design corresponds to the 
BOTTOM library name. 

To check the mirror layer and library layer settings 

1 Choose the spreadsheet toolbar button, then choose Layers. The Layers 
spreadsheet displays. 

2 Check the settings, then close the Layers spreadsheet. 
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Weighting and color-coding nets 

Layout places a higher priority on keeping higher-weighted nets and their 
components together during placement. In Layout, nets are weighted on a linear 
scale from 0 to 100. 

To weight and highlight nets 

1 Choose the spreadsheet toolbar button, then choose Nets. The Nets spreadsheet 
displays. 

2 Double-click in the Net Name cell in the spreadsheet that corresponds to a net 
whose weight you want to change, or that you want to highlight. The Edit Net 
dialog box displays. 

3 To change the weight for a net, type in a new weight in the Weight text box, 
then choose the OK button. 
or 
Use the scroll bar at the left of the text box to change the number, then choose 
the OK button. 

The new number shows in the Weight column of the spreadsheet. 

4 To highlight a net, enable the Highlight option, then choose the OK button. 

The net shows in the highlight color. 

! Tip To assign a color to a net other than the highlight color, click in the Color 
cell in the Nets spreadsheet, choose Change Color from the pop-up menu, then 
select a color from the color palette displayed. 

W See For information on setting net properties, see Chapter 5: Setting up the 
board in the OrCAD Layout for Windows User's Guide. 

To color-code a net 

1 In the Nets spreadsheet, select the net(s) to which you want to assign a color. 

2 From the pop-up menu, choose Change Color, then select a color from the 
palette that displays. 
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Checking gate and pin information 

A package is the electronic gate and pin infonnation associated with a component 
(as opposed to a footprint, which is the infonnation regarding the physical 
characteristics of a component). The infonnation in the Packages spreadsheet is used 
to detennine whether you can swap gates between identical components or only 
within a component, and how the gates are arranged within a part. 

To check gate and pin information 

1 Choose the spreadsheet toolbar button, then choose Packages. The Packages 
spreadsheet displays. 

2 Verify that the following infonnation in the spreadsheet is correct: 

• Package Name. A text string that designates the name of the electrical 
package. 

D Gate Name. Usually an alpha character that designates which gate each pin 
belongs to. Each gate in a package must have a unique gate name, and all of 
the pins in the same gate must share the same gate name. 

D Pin Name. Identifies each pin in tenns of its electrical characteristics (INA, 
INB, and so on) so that Layout can swap gates correctly. Each pin within a 
gate must have a unique identifier. For swappable gates, corresponding pins 
must have identical pin names. 

• Gate Group. An integer used to detennine which gates can be swapped. 
Any gates that are assigned to the same Gate Group are swappable. Gate 
Group 0 is a special case that represents a non-swappable gate. 

• Pin Group. An integer used to detennine which pins can be swapped. Any 
pins that are assigned to the same Pin Group are swappable. Pin Group 0 is 
a special case that represents a non-swappable pin. 

a Pin Type. Usually set to None for standard TTL-type pins, which indicates 
that the pin is not part of an ECL net, and is not a source, a tenninator, or a 
load. You can assign a Pin Type of None, Source, Tenninator, or Load. 

3 Close the spreadsheet when you are finished viewing the infonnation. 
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Securing pre-placed components on the board 

If your design has components or footprints that were placed at the schematic level 
or as part of the template, you should ensure that they were placed properly before 
you begin placing additional components. Pre-placed components may include 
connectors, mounting holes, memory arrays, predefined circuits, alignment targets, 
and components that must be placed in specific locations due to mechanical or 
temperature restrictions. 

Once you are satisfied that the pre-placed components are properly placed, you must 
affix them to the board using the Fix Comps or Lock Comps commands. Otherwise, 
they may be moved inadvertently when you are placing other components. The Lock 
Comps command is temporary; you can easily override the command. 

The Fix Comps command must be disabled in the Edit Component dialog box. The 
Fix Comps command is intended for parts like connectors and mounting holes that 
need to be placed permanently in specific locations. 

To lock components on the board 

1 Choose the Component toolbar button. 

2 To select all of the pre-placed components, hold the left mouse button down 
while you drag the mouse, drawing a rectangle around the components. Release 
the left mouse button. Every selected component is highlighted. 

3 To temporarily lock components in a location, choose Lock Comps from the 
pop-up menu. 
or 
To permanently fix components in a location, choose Fix Comps from the pop
up menu. 

To override the Lock Comps command 

1 Select a locked component. A dialog box asking "One or more components 
locked. Override?" displays. 

2 Choose the OK button. The component is unlocked. 

To override the Fix Comps command 

1 Choose the spreadsheet toolbar button, then choose Components. The 
Components spreadsheet displays. 

2 Double-click on the row for the component that you want to move. The Edit 
Component dialog box displays. 

3 In the Component flags group box, deselect the Fixed option. 

4 Choose the OK button to close the Edit Component dialog box. 

28 OrCAD Layout for Windows Getting Started 



Chapter 4 Placing components 

Creating height or group keepins and keepouts 

You can restrict component placement based on physical constraints using the Comp 
height keepin or Comp height keepout obstacle types. A height keepin contains all 
components at or above a specified height, while a height keepout excludes all 
components at or above a specified height. 

You can also restrict placement based on group number (assigned in the schematic) 
using the Comp group keepin or Comp group keep out obstacle types. A group 
keepin contains all the components in a specified group, while a group keepout 
excludes all the components in a specified group. 

To create keepins and keepouts 

1 Select the Obstacle tool from the toolbar. 

2 From the pop-up menu, choose Insert. 

3 Draw a rectangle that defines the desired keep in or keep out area. 

4 Double-click on the rectangle. The Edit Obstacle dialog box displays. 

5 In the Obstacle Type drop-down list, select Comp height keepin or Comp height 
keep out. In the Height text box, enter a number corresponding to the height of 
the components you want to include or exclude and choose the OK button. 
or 
In the Obstacle Type drop-down list, select Comp group keepin or Comp group 
keepout. In the Group text box, enter a number corresponding to the group 
number of the components you want to include or exclude, then choose the OK 
button. 

6 From the pop-up menu, choose Finish. If you created a component height 
restriction, the rectangle displays the height number and the words "Comp 
keepin" or "Comp keepout." If you created a group restriction, the rectangle 
displays the group number and the words "Group number keepin" or "Group 
number keepout." 
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Loading a placement strategy file 

Strategy files set up your display so you can see what you need to see during 
component placement by highlighting appropriate elements such as place outlines, 
electrical connections, and reference designators, and making irrelevant elements 
(such as plane layers) invisible. OrCAD recommends loading the strategy file 
PLSTD.SF before performing manual placement. 

To load a placement strategy file 

1 Choose Load Strategy from the File menu. The Load Strategy File dialog box 
displays. 

2 Select the strategy file PLSTD.SF from the list and choose the Open button. 

Disabling the power and ground nets 

If the power and ground nets are not critical to placement, disable routing for all nets 
attached to plane layers. This significantly improves system performance during 
placement, as these (typically) large nets often have no bearing on placement. 

To disable routing for nets attached to plane layers 

1 Choose the spreadsheet toolbar button, then choose Nets. The Nets spreadsheet 
displays. 

2 Using the CTRL key, select the nets that are attached to plane layers. 

3 From the pop-up menu, choose Enable<->Disable. In the Nets spreadsheet, the 
Routing Enabled column for the nets changes to No*. 
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Placing components manually 

There are several commands available in Layout to assist you in manually placing 
components on a board. You can place components one at a time or in groups. This 
section describes how to place components manually. 

~ Tip Before you begin placing components, save your board file. 

m See For information on circular placement, matrix placement, moving 
components, and editing components, see Chapter 8: Placing and editing 
components in the DrCAD Layout for Windows User's Guide. 

Use the Select Criteria command to make a component or group of components 
available for placement. Using this command with the Next Comp command, you 
can select one or more components based on a set of criteria (component name, 
footprint name, or use wildcards), then place the components individually using the 
Next Comp command. 

To place components individually 

1 Choose the Component toolbar button. 

2 Choose Select Criteria from the pop-up menu. The Component Selection 
Criteria dialog box displays. 

R:J Note The Select Criteria command and the Select Any command display the 
same dialog box, but have different functions. The Select Criteria command makes 
certain components available for placement by the Next Comp command. The 
Select Any command actually selects specified components or groups for 
placement, attaching them to the cursor. 

3 Enter the name (or other criteria) of the component that you want to place in the 
appropriate text box and choose the OK button. (Choose the dialog box's Help 
button for information on the options in the dialog box.) 

:! Tip Usually, when you use the Select Criteria command, you will want to make 
more than one component available for placement. You can specifY more than one 
component using wildcards: use an asterisk (*) as a substitute for multiple 
characters and a question mark (?) as a substitute for a single character. For 
example, if you enter U*, you will select all components with names beginning 
with the letter U. 

4 Choose Next from the pop-up menu. The component snaps to the cursor. If you 
selected a group (such as all components beginning with the letter U), then the 
component with the greatest number of connections that meets the specification 
snaps to the cursor. 

5 Drag the component to the desired location and click the left mouse button to 
place it. 
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Selecting the next components for placement 

Use the Select Next command (available on the Edit menu and the pop-up menu) to 
display a dialog box that lists the components yet to be placed. If you made 
components available for placement according to certain criteria (using the 
Component Selection Criteria dialog box), Layout displays only the components that 
remain to be placed that meet that criteria. From this list, you can select the next 
component that you want to place. 

If there are too many components to list, Layout displays a dialog box that reports 
the number of components that remain to be placed. The default selection that 
appears in the text box is the one that Layout would automatically choose if you 
used the Next Comp command. You can accept the default, or enter a new choice. 

To select the next component for placement using Select Next 

1 Choose the Component toolbar button. 

2 Choose Select Next from the pop-up menu. The Select Next dialog box 
displays. 

3 Select the component for placement, or enter the component name in the text 
box, then choose the OK button. 
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Placing component groups 

You can assign functionally related components to groups at the schematic level. 
When you speCify the group number (as assigned in the schematic) in the 
Component Selection Criteria dialog box, the components assigned to the group 
snap to the cursor for placement. 

To place a component group 

1 Choose the Component toolbar button. 

2 Choose Select Any from the pop-up menu. The Component Selection Criteria 
dialog box displays. 

3 Enter the group number, as assigned at the schematic level, in the Group 
Number text box and choose the OK button. The group of components snaps to 
the cursor. 

4 Click the left mouse button to place the components on the board. 

Using Mincon to optimize placement 

Use the Mincon command to evaluate the connections within a net and find the 
shortest route for the net (ratsnest) based on the placement of the pins or components 
on the board. When nothing is selected, Mincon is a global command; it affects the 
entire board each time you apply it. However, if you have selected one or more 
components, Mincon only affects the nets attached to the selected components. 

To use the Mincon command 

1 Choose the Component toolbar button. 
or 
Choose Component from the Tool menu. 

2 Choose Mincon from the pop-up menu. Layout minimizes the connections 
between components. 
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Checking placement 

You should check the placement of a board using Place Design Check, the density 
graph, and the placement information in the Statistics spreadsheet. 

Using Place Design Check 

Before you route the board, you should run Place Design Check. Place Design 
Check looks for component-to-component spacing violations and for other 
placement errors, such as components that violate height restrictions, components 
that violate insertion outlines, and components that violate grid restrictions. 

Place Design Check uses component outlines to determine whether there is a spacing 
violation. Therefore, component outlines should encompass the entire area of the IC 
or discrete component, including such objects as pin-out patterns and sockets. 

Any problems found by Place Design Check are marked by a circle and can be 
queried using the Error tool and query window. 

m See For information on how to use the error tool to get more information about 
reported errors, see Chapter 6 in this manual. 

To run Place Design Check 

~ From the Auto menu, choose Place Design Check. Layout checks the board for 
component placement violations; 
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Chapter 4 Placing components 

Using the density graph 

The density graph displays a graphical representation ofthe connection density of 
your board. Using colors ranging from blue and green (acceptable density) to pink 
and red (very dense), the density graph represents the degree of difficulty that will be 
faced in routing the board. 

The density graph analyzes all routing layers, routed tracks, widths of tracks, spacing 
rules, DRC settings, and connections to calculate the available routing channels. It 
shows the crossing count at each location of the board in relation to how much of 
each cell is being filled by a pad, track, or connection. 

There are two kinds of data shown on the density graph: the board density at each 
location (the number of pads and connections in a given area of the board), and the 
track density (the track density in each channel), shown as bar graphs at the top and 
right. 

rg; Density - (ORe OFF) I!I~ E3 

To open the density graph 

1 From the Window menu, choose Graphics Windows. The Select Graphic 
Window dialog box displays. 

2 Choose Density Graph, then choose the OK button. The design window is 
minimized and the density graph window displays. 

FiJ Note A small amount of red in the density graph is acceptable, but you should 
attempt to keep the percentage of red below 25%, because a board that is more 
than 25% red is likely to encounter serious routing difficulties. 

3 To return to the design window, minimize or close the density graph window, 
then open the design window. 
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Chapter 4 Placing components 

Viewing placement statistics 

When you finish placing components on the board, you can view the component 
placement statistics in the Statistics spreadsheet. The spreadsheet shows the 
percentage and number of components placed, how many were placed off the board, 
and how many were placed in clusters. 

To view placement statistics 

1 Choose the spreadsheet toolbar button, then choose Statistics. The Statistics 
spreadsheet displays. 

2 Scroll until you find the Place data. 

3 Close the spreadsheet when you are finished viewing the statistics. 
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Chapter 5 

Routing critical nets 

After you have placed the components, you can route the board to form the electrical 
connections between the components. This chapter explains how to route critical 
nets manually. Critical nets are those that must meet some requirement other than the 
default settings, such as length. 

Push-and-shove routing 

Layout's autorouter uses push-and-shove routing, which minimizes vias and allows 
extremely dense autorouting, and interactive routing, which allows you to use 
Layout's automatic routing capabilities without sacrificing routing control. 

Wherever Layout's autorouter finds the optimum space in which to place a track, it 
checks to see if it is possible to "shove" any existing tracks or vias out of the way to 
get the track in. Ifthat is not possible, the autorouter checks beyond any blocking 
pads to see if it can jump over them to clear a path. 

Layout's autorouter also checks to see ifthere are obstructing tracks that can be 
cleared (or rerouted) without deleting anything. If that is not possible, the autorouter 
looks for the next best location for the track. However, if a path can be cleared by 
any of Layout's algorithms, Layout clears it, then goes on to the next connection. 

Interactive routing 

Layout has an interactive routing feature that allows you to direct routing wherever 
necessary, while still having access to Layout's autorouting algorithms. 

If you have purchased Layout or Layout Plus, you can use the autorouter and 
enhanced manual routing commands to route the board, and then use the manual 
routing commands described in this chapter to optimize routing. 

m See For information specific to autorouting and enhanced manual routing, see 
the DreAD Layout/or Windows Autorouter User's Guide. 
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Before you begin routing 

You probably defined the following parameters when you set up the board.· If not, 
you need to do so before you route the board. 

• Designate appropriate layers as plane layers or routing layers 

• Define vias 

• Set or verifY net properties 

WI See For information on properly designating layers and defining vias, see 
Chapter 3 in this manual. For information on setting or verifYing net properties see 
Chapter 5: Setting up the board in the OrCAD Layout for Windows User's Guide. 

After you have checked the above items, you are ready to begin the routing process. 
The steps in the manual routing processes are listed below. 

• Check the board outline, via definitions, and routing grid 

• Load a strategy file 

• Fanout SMDs and verifY connections to power and ground 

• Route the remaining signals 

m· See For information on using copper pour, see Chapter 10: Using thermal 
relieft and copper pour zones in the OrCAD Layout for Windows User's Guide. 

• Optimize routing using the manual routing commands 

W See For information on optimizing routing using manual routing commands, 
see Chapter 9: Routing the board in the OrCAD Layout for Windows User's 
Guide. 

• Run design for manufacturability checks 

IW See For information on running design for manufacturability checks, see 
Chapter 6 in this manual. 
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Preparing the board for routing 

Before you route, you need to check the settings for the board outline, vias, and 
routing grid. This is helpful whether you plan to route the board manually or using 
the autorouter. 

• Verify that the board outline has a desirable amount of internal clearance, that 
there is only one board outline, and that it is on the global layer. 

• Inspect the vias in the Padstacks spreadsheet to make sure that they are the right 
size and on the correct layer. 

• Verify that the routing grid and via grid match for the placement of tracks on the 
board. 

m See F or information on creating and editing a board outline, defining vias, and 
setting the routing grid, see Chapter 3 in this manual. 

Routing the board manually 

When you view the board before routing has occurred, you see the parts, and many 
fine lines running between them. These lines are known as the ratsnest. The ratsnest 
lines represent the connections that need to be routed to form the necessary tracks on 
the board. 

~ Tip Yellow triangles in the ratsnest indicate unrouted, zero-length connections 
(connections that lead directly from a pad on the top layer to a pad on the bottom 
layer). Running Mincon will usually remove these from your board. 

When routing the board, make the necessary connections to the plane layers first, 
and then route the remaining tracks. 

m See For information on using a DRC box, and on using the Curve Route, 
Gridless Route, and Gridded Manual Route without shove tools, see Chapter 9: 
Routing the board in the OrCAD Layout for Windows User's Guide. 

m See Before routing, run a Place Design Check and a full-board Board Space 
Check, and be sure to correct any spacing violations before starting to route. For 
information on running Place Design Check, see Chapter 4 in this manual. For 
information on running Board Space Check, see Chapter 6 in this manual. 

~ Tip Before you begin routing the board, save your board file. 
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Chapter 5 Routing critical nets 

Loading a routing strategy file 

In manual routing, a strategy file sets up the graphical display appropriately for 
routing. There are many strategy files provided with Layout. Load the strategy file 
that is most suitable for your board. 

m See For a complete list of routing strategy files provided with Layout, see 
Strategy files in Appendix A: Understanding the files used with Layout in the 
Ore AD Layout/or Windows User's Guide. . 

To load a routing strategy file 

1 From the File menu, choose Load Strategy. The Load Strategy File dialog box 
displays. . 

2 Select a strategy file (.sF) from the files listed, then choose the OK button. 
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Chapter 5 Routing critical nets 

Routing power and ground 

In Layout, plane layers are typically used for power (VCC) and ground (GND). 
When routing multilayer boards, it is essential to route power and ground first. To do 
so, you should enable power and ground nets for routing and disable all other signals 
for routing. This causes all signal ratsnest lines to disappear. 

m See Before you can route power and ground, you need to designate plane layers 
in the layer stack. For information on designating layers as plane layers, see 
Chapter 5: Setting up your board in the OrCAD Layout for Windows User's 
Guide. 

On surface-mount technology boards, you must perform manual fanout to connect 
SMDs to the plane layers. 

On through-hole boards, the appropriate nets are automatically attached to the plane . 
layers with thermal reliefs. Ifpower or ground did not connect to the plane, one of 
three errors may have occurred in the netlist: the global power pin is not defined in 
the part, the pin is not connected to the proper signal, or if the pin is connected, it 
does not have the correct signal name. To remedy the problem, you can either 
modifY the schematic and reannotate, or you can modifY the board by adding a pin to 
the signal. Keep in mind that this board modification cannot be back annotated to the 
schematic. 

Connections to the planes may be verified prior to post processing by verifYing that 
only nets to be connected to the planes are enabled, then referring to the Statistics 
spreadsheet to verifY that these nets are 100% routed. If anything less than 100% 
routing is displayed in the Enabled column in the Statistics spreadsheet, the 
remaining connections may be found (in the design window) by selecting a routing 
tool and choosing Next from the pop-up menu. 

m See You can also view the thermal connections using the post process preview. 
For more information, see Previewing thermal reliefs in Chapter 10: Using 
thermal reliefs and copper pour zones in the OrCAD Layout for Windows User's 
Guide. 

m See For information on adding pins to nets, see Adding pins to nets in Chapter 
9: Routing the board in the OrCAD Layout for Windows User's Guide. 

After routing power and ground nets, you must disable them and enable all other 
signals for routing. Then you can route the remaining signals. 

~ Tip Since ratsnest lines are only displayed for enabled nets, you can control 
which ratsnest lines are visible by controlling which nets are enabled for routing. 
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Chapter 5 Routing critical nets 

The steps in the power and ground routing process are listed below: 

• 

• 
• 

• 

Enable the power and ground nets for routing and disable the other nets 

Perform fanoutto connect SMDs to the plane layers 

Verify proper connection to the plane layers for through-hole components 

Disable the power and ground nets for routing and enable the remaining nets 

To enable power and ground for routing 

1 Choose the spreadsheet toolbar button, then choose Nets. The Nets spreadsheet 
displays. 

2 Double-click in the title cell ofthe Routing Enabled column. The Edit Net 
dialog box: displays. 

3 Deselect the Routing Enabled option, then choose the OK button. The Routing 
Enabled for all nets changes to No. 

4 While the Nets spreadsheet is displayed, press the TAB key to open the Net 
Selection Criteria dialog box. 

5 Enter VCC in the Net Name text box provided, then choose the OK button. The 
VCC net is highlighted in the Nets spreadsheet. 

6 From the pop-up menu, choose Modify. The Edit Net dialog box displays. 

7 Select the Routing Enabled option. 

8 Choose the Net layers button to invoke the Layers Enabled for Routing dialog 
box. 

9 Select POWER in the Plane Layers group box. 

10 Choose the OK button twice to dismiss the dialog boxes. The Routing Enabled 
for the VCC net changes to Yes*. 

11 Repeat steps 4 through 10 for the ground net, using GND as the net name and 
the plane layer. 

12 Close the Nets spreadsheet. 

RJ Note In the Nets spreadsheet, the asterisk (*) next to the Yes or No indicates 
that the net has special layer considerations. For example, it could indicate that the 
net is connected to a plane, or that one of the routing layers is disabled for the net. 
You can check which layers are enabled for a given net using the Enable Layers 
for Routing sub-dialog box accessed through the Edit Net dialog box. 
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Chapter 5 Routing critical nets 

To verify connections to the planes 

1 Open the Statistics spreadsheet and locate the Enabled column for routing. You 
should see a value of 100% in the Enabled column indicating that the 
appropriate nets are indeed connected to the plane layers. 

2 Ifthe value is anything less than 100%, choose a routing tool and choose Next 
from the pop-up menu. The window centers on the offending connection. The 
connection attaches to the cursor for routing. 

3 Connect the net to the appropriate plane layer. 

To manually fanout surface mount devices 

1 Choose the Gridded Manual Route tool. 

2 Select a VCC or GND net for routing. 

3 Route the net to the point at which you want to insert the via. 

4 Press the SPACEBAR to insert a vertex (a point where a via will be placed). 

5 Choose Insert Via from the pop-up menu to connect the net to the plane layer. 

To route power and ground on a board with no plane layers 

1 Choose the Gridded Manual Route without shove tool. 

2 Select the VCC or GND net. 

3 Route the net. 

To disable the power and ground nets and enable other nets 

1 Choose the spreadsheet toolbar button, then choose Nets. The Nets spreadsheet 
displays, showing Routing Enabled set to Yes* for VCC and GND, and set to 
No for the rest of the nets. 

2 Click once in the title cell of the Routing Enabled column. The entire column is 
highlighted. 

3 From the pop-up menu, choose Enable<->Disable. The Routing Enabled for the 
VCC and GND nets changes to No*, and the Routing Enabled changes to Yes 
for the rest of the nets. 
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Using interactive push-and-shove routing 

The Shove Route tool facilitates interactive routing because you are actually 
interacting with the automatic routing capabilities of Layout when you use it to route 
a track. The Shove Route tool automatically moves existing tracks out of the way of 
the track you are currently routing. 

Setting an interactive routing strategy 

In the Manual Route Strategy dialog box, you can use High Power, Medium Power, 
and Low Power to control how much shove power is used by the Shove Route tool. 

To set routing parameters for Shove Route 

1 From the Options menu, choose Manual Route/Shove Rules. The Manual Route 
Strategy dialog box displays. 

2 In the Shove Route Control group box, set these options: 

• High Power. The router may rip-up, shove, and re-route existing tracks as 
you add new tracks. 

• Medium Power. The router shoves tracks and may even push routes over 
other items such as pads and around other tracks in an attempt to move 
them out of the way as you add new tracks. 

• Low Power. The router moves tracks only slightly, or conservatively, in an 
attempt to move them out of the way as you add new tracks. 

3 Choose the OK button. 
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Chapter 5 Routing critical nets 

Using the Shove Route tool 

When you use the Shove Route tool, Layout shoves other tracks out of the way of 
the track that you are currently routing. With this tool, you can pick up individual 
connections and route them aided by the shove capability, manually route critical 
tracks, and edit tracks and vertices. 

To use the Shove Route tool 

1 From the Tool menu, choose Shove Route. 

2 From the View menu, choose Zoom In. The cursor becomes a "Z." 

3 To magnify the connection you plan to route, position the cursor over the 
connection and click the left mouse button. Then, press the ESC key to exit zoom 
mode. 

4 Select the connection from the ratsnest. The connection attaches to the cursor. 

S Begin routing the connection by moving the cursor in the general direction of 
the target pad. You can route using 45° or 90° angles. Unlike manual routing 
with DRC enabled, these paths may temporarily intersect other existing tracks. 

6 Click the left mouse button or press the SPACEBAR to create vertices (corners). 
Near the last segment for the connection, the tool automatically finishes the 
connection to the center of the target pad. A complete connection is indicated by 
the cursor changing size (it gets bigger), and the ratsnest disconnecting from the 
cursor. 

~ Tip When you use the Shove Route tool, the router does not automatically show 
you where vias are needed. To change layers while routing a track, press the 
accelerator key for the target layer. The router clears away tracks around the via 
you are inserting when you click the left mouse button to aCGept the first segment 
on the new layer. 
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Chapter 5 Routing critical nets 

Checking routing 

You can check the routing of a board using the density graph or the routing 
information in the Statistics spreadsheet. 

1m See For information on opening and viewing the density graph, see Using the 
density graph in Chapter 4 in this manual. 

Changing board density using routing strategy files 

If your board is too dense in certain areas (indicated with dark red), you can improve 
the density by experimenting with different routing strategies. For example, you may 
want to initially tum off routing on the top layer of the board by changing the 
routing layer parameter of a strategy file. 

Layout supplies a variety of routing strategy files that affect board density in 
different ways. 

m See For a description of the routing strategy files available with Layout, see 
Appendix A: Understanding the files used with Layout in the OreAD Layout for 
Windows User's Guide. 

To experiment with different routing layer strategies 

1 Choose the spreadsheet toolbar button, choose Strategy, then choose Route 
Layer. The Route Layer spreadsheet displays. 

2 Double-click in the Win/Comp section of the spreadsheet on the row ofthe 
layer that you want to disable for routing. The Edit Layer Strategy dialog box 
displays. 

3 Deselect the Routing Enabled option to turn off routing on the layer, then 
choose the OK button. 

4 Close the spreadsheet. The· density graph redraws itself, presenting new board 
density data resulting from turning off routing on the layer. 

To load a routing strategy file 

1 With the density graph window displayed, from the File menu, choose Load 
Strategy. The Load Strategy File dialog box displays. 

2 Locate and select a strategy file (.SF) and choose the Open button. The density 
graph redraws itself, presenting new board density data resulting from loading 
the strategy file. 
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Chapter 5 Routing critical nets 

Viewing routing statistics 

When you have finished routing the board, you can view the routing statistics in the 
Statistics spreadsheet. The spreadsheet gives the percentage and number of 
connections completed, via data, and more. 

To view the routing statistics 

1 Choose the spreadsheet toolbar button, then choose Statistics. The Statistics 
spreadsheet displays. 

2 Scroll until you find the Route data. 

3 Close the spreadsheet when you are finished viewing the statistics. 
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Chapter 6 

Checking the board 

This chapter explains how to use Layout's design rules and manufacturability checks 
(Board Design Check, Board Space Check, Board AutoCDE, and Board AutoDFM) 
to test the integrity of the board. 

Using Board Design Check 

Board Design Check verifies the board's adherence to design rules. Board Design 
Check automatically sweeps through the entire design checking for design rule . 
errors. You tell Layout which checks you want to run by selecting the options in the 
Design Rules dialog box. 

To use Board Design Check 

1 From the Auto menu, choose Board Design Check. The Design Rules dialog 
box displays . 

. 2 Select the rules that you want to verifY. (Choose the dialog box's Help button 
for information on the dialog box's options.) 

3 Choose the OK button. Layout performs the specified checks and flags the 
errors with circles on the board. 

W See For information on querying errors using the error tool, see Investigating 
errors in this chapter. 
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Using Board Space Check 

Board Space Check verifies board spacing criteria. Layout does not allow spacing 
errors to be created during interactive routing (or autorouting in Layout and Layout 
Plus). 

It is always recommended that you run Board Space Check, but it is especially 
important to do so if you have disabled DRC at any time during the design process. 

The internal spacing information on the routing window is continuously updated, so 
that a spacing check takes only a few minutes. Any problems in spacing are marked 
by a circle and can be queried. 

To use Board Space Check 

~ From the Auto menu, choose Board Space Check. 

Layout checks the board for spacing errors and flags the errors with a circle. 

m See For information on querying errors using the error tool, see Investigating 
errors in this chapter. 

Using Board AutoCDE . 

Board AutoCDE automatically sweeps through the entire design, checking for space 
check errors, and automatically rips up a minimum number of segments to eliminate 
any electrical shorts. Using Board AutoCDE, you can accurately judge the impact of 
engineering change orders and achieve a clean design for rerouting. 

To use Board AutoCDE 

~ From the Auto menu, choose Board AutoCDE. Layout checks the board and 
rips up offending segments. 
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Using Board AutoDFM 

Board AutoDFM automatically smoothes, miters, and checks for both aesthetic and 
manufacturing problems that may have been created during routing. You should run 
Board AutoDFM at least once, at the end of the design cycle. 

Some of the problems recognized by Board AutoDFM may include off-grid 900 

angles, acute angles, bad copper share, pad exits, and overlapping vias. Any 
problems are marked by a circle and can be queried. 

To use Board AutoDFM 

~ From the Auto menu, choose Board AutoDFM. 

Layout smoothes, miters, and checks the board. 

!WI See For information on querying errors using the error tool, see Investigating 
errors in this chapter. 

Investigating errors 

When you run Board Design Check, Board Space Check, or Board AutoDFM, the 
errors are flagged on the board with circles. You can query the errors to receive a 
full description of the problem. 

R:J Note You can also view the errors in the Error Markers spreadsheet. 

To query flagged errors 

1 From the Tool menu, choose Init Query. The query window displays. 

2 Select an error flag. A description of the error displays in the query window. 

3 Take the necessary action to reconcile the error. 
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Post processing 

W See For information on post processing, including using Setup Batch to preview 
layers in the Post Process spreadsheet, and using Run Batch and Drill Tape to 
generate Layout output reports, see Layout's online help. 

m See For information on creating output Gerber files, .see Layout's online help. 
For information on how to use GerbTool, see the OrCAD Layoutfor Windows 
GerbTool User's Guide. 

Wi See For information on creating output .DXF files for input to AutoCAD or 
other mechanical CAD applications, see the OrCAD Layout for Windows Visual 
CADD Tutorial. For information on how to use Visual CADD, see the OrCAD 
Layoutfor Windows Visual CADD User's Guide. 
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